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1 EZ-ROUTE Evaluation Package

1.1 Introduction

The purpose of this package is to help vou evaluate the schematic
capture, PC board layout, and auto-routing software of the
EZ-ROUTE system. This evaluation package is divided into several
sections. The sections are arranged in order of increasing detail. The
first section gives a general overview of the entire EZ-ROUTE system.
Other sections include specifications, software installation, self-running
demonstrations, and hands-on tutorials. The final section gives
information on how to order EZ-ROUTE products.

1.2 Contents of the Evaluation Package

The evaluation package contains special versions of the EZ-ROUTE
schematic editor, PC board layout editor, and PC board auto-router.
Also included are the schematic and PC board hard copy utilities. The
package is designed to give you hands-on experience using the software.
We think this package will convince you that this system can create and
maintain PC designs easily and efficiently. This is a cost effective system.

If, after purchasing the EZ-ROUTE product, you arc not
satisficd with its performance, you may rcturn it within 30 days
for a full and prompt refund of the purchasc price.

1.3 Limitations of the Evaluation Package

The programs furnished in the evaluation package function exactly like
the real version except that you will not be able to save your designs to a
disk file. The library of parts in the evaluation package contains only
the parts and symbols required in the demos and tutorials. The real
version comes with complete libraries of over 1000 symbol/part
combinations. The evaluation package does not contain all the utilities
of the complete EZ-ROUTE system. The next section describes the
entire EZ-ROUTE system as it is delivered.
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Design Files:
Schematics
PC Boards

Schema

Orcad

Futurenet

Pcad

Applicon Bravo
Applicon Leap
Compulervision
Calay

Cadnetix
Scicards

Spice

Telesis

Vectron
Multiwire

EZ-ROUTE System
Supervisor

g ’ AMSCAD
Schematic En

N\ - i

Libraries:
Parts
Symbols
Packages
Footprints

CELL-ll, PLOT

Edif Report Generator
EDIF

Convert/Update Utility

PCBRIDGE

PC Board Layout
PCPRO-1II, PCPLOT

Autorouter
PCROUTE, PCSCHED

Design Rule Checker
PCCHECK

Font Editor
EDFONT

Hard copy:
Schematics
PCB Masks
Net list
Parts list
Pin list

Devices:
Gerber

HP Plotters
HP Laserjet
Houston Inst.
IBM Printers
Epson Printers
Okidata
Postscript

Figure 1-1. EZ-ROUTE Integrated System
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2 Overview of the EZ-ROUTE System

This section of the evaluation package is designed to give you an
overview of the entire EZ-ROUTE system. A description of each of
the major components, and how they interact with each other is
presented.

2.1 EZ-ROUTE Supervisor Program

The EZ-ROUTE supervisor program, AMSCAD, provides a smooth
flow between the major components of the layout system. With this
program, you do not need to remember or type program names. You
select the schematic editor, PC board editor, or run demonstrations and
other programs directly from menus. After running a program, you will
return to the AMSCAD supervisor, ready to perform the next step in
your layout.

Although the AMSCAD program provides an easy way to use the
layout system, it is not required. All the programs in the layout system
may be run directly without the use of the supervisor program. Also,
the major subsystems of the EZ-ROUTE system are sold separately.

The supervisor program, as well as all the programs in the EZ-ROUTE
family, have a consistent and easy to use interface. Selections are made
from pull-down and pop-up menus. On line, context sensitive help is
always available by pressing the F1 function key. Selection of file names
is presented in menu form. The interface is object oriented. That is,
you do not have to "back out" of the current operation to select
another command or make option settings. You always just indicate
what you want to do next. We know of no_other competitor that has
this modern, state of the art, type of user interface.

2-1
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AMSCAD: Program Manager 21:33:45
File EXI0KI 48 Pcpro-11 ﬁutorouter tilities
izl Schematic editor,. |50 i
Font editor..
Demo. .

FifHelp. Select next:opérafian..l :

Figure 2-1. EZ-ROUTE Supervisor

A brief description of the functions provided by the supervisor program
is given in the following sections. General descriptions are given here.
Complete program specifications and limitations are given at the end of
this section.

2.2 File Menu

The functions on the file menu allow you to perform general
housekeeping operations, such as changing the working directory,
entering a DOS shell, and exiting the program.
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Loading tUnassigned | 876 837
dit - -

Save
"save As.

Get synmbol
Put synmbol

pRint

Chg Dar
dos shell F7

aBout

&%
D | DO 4

RREAQURC

232

F1 Help. ESC Menu

Figure 2-2. CELL-II Schematic Editor

2.3 Schematic Entry

The CELL-II menu provides access to the programs in the schematic
layout system.

The Schematic Editor is used to create, edit, and maintain schematic
drawings. The editor can also be used to draw part symbols, and to
maintain the part, package, and symbol libraries.

The EDIF Processor generates net, pin, part, and numerous other
reports from schematic drawings, including the initial placement of a PC
board for use by the PC layout system.

The Font Editor allows you to customize or design your own character
fonts for use on schematic drawings.
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The Demo function is used to start a self-running demonstration of the
schematic layout system.
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Figure 2-3. PCPRO-II PC Board Editor
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2.4 PC Board Layout System

The PCPRO-IT menu provides access to the programs in the PC board
layout system.

The PC Board Editor is used to create, edit, and maintain the layout
masks for PC board designs. The editor is also used to make PC board
footprint symbols, and to print net lists, part lists, and other PC board
specific reports.

The Print/plot program generates hard copy output of PC board masks.
Popular printers, plotters, and photo- plotters are supported.

The Font Editor allows you to customize or design your own characters
for use on a board layout, such as the text used on the silk-screen mask.
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The Demo function starts a self-running demonstration of the PC board
layout system.
SRR R oard Autorouter

]
e

ROUTING CONTROLS ROUTING PASSES

LAYERS E'Huriznntali 1 1 Memory
Uertical: 2 x 2 Easy Z
r—— Line Line: 18 x 3 Mediun  NO 45s
CLEARANCE  Via-Line: 18 x 4 Hard _l
L Uja-Pad: 18 5 Uery Hard
— Low X: a
ROUTING Low ¥: 7} x 6 Memory —
AREA High X: 7580 7 Basy 2 _|
L— High ¥: 4800 B Medium  45s

ROUTING ——l: x: 58 9 Hard
GRID ¥ 50 18 Very Hard J
Pad # for Vias: 3
Routing Line Width: 18

ENTER to Change i Begin Routing J

Figure 2-4. EZ-ROUTE Auto-router

2.5 Auto-router

The Auto-router menu provides access to the functions associated with
the automatic routing of the electrical connections of a PC board.

The Schedule Routes function is used to automatically generate the
routing schedule for a PC board. The schedule is normally used by the
auto-router, but may also be used to assist you in manual layout by
showing which points on a PC board must be electrically connected.

The Auto-router uses artificial intelligence to automatically route the
electrical connections of a PC board. The auto-router will preserve any
nets that you wish to pre-route manually. Also, the auto-router
provides for being interrupted, editing the board with the editor, and
restarting the router.
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The Demo function starts a self-running demonstration of the
auto-router program.

2.6 Utilities

The utility functions are used to convert data from other popular CAD
systems to the EZ-ROUTE system (and vice/versa), and to verify that a
PC board layout agrees with the schematic drawings and design rules.

The PC Bridge program provides a "bridge” between the EZ-ROUTE
system and other popular CAD systems. This program is also used to
verify and/or update a PC board’s design data when changes are made
to the schematics for the board.

The PC Check program checks a PC board layout for agreement with
physical design rules. Such things as clearances of lines to pads, lines to
lines, lines to vias, as well as numerous other checks are performed.

The Smartwork Convert function converts a Smartwork PC board file
to an EZ-ROUTE board file.
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3 Specifications

The following is a summary of the specifications for the EZ-ROUTE
system.

3.1 System Wide Features R

= Runs on IBM PC, IBM-XT, IBM-AT, IBM-PS/2 and compatible
computers.

= May be used with or without a mouse device.

= State-of-the-art user interface with pull-down menus and dialog boxes.

= On-line and context sensitive help.

= Complete user manuals with tutorials for all the major subsystems.

= Video support for CGA, EGA, VGA, and Hercules graphic cards.

= Hard copy support for Epson, Hewlett-Packard, IBM, and Gerber
printers/plotters. For an exact list, refer to the enclosed specification
list.

3.2 Schematic Entry

= Sheet sizes A through E, and custom.

= Multiple sheets per design.

= Simple move, copy, erase, and draw operations.

= Drag symbols while keeping net line connections.

= Modern symbol/part libraries with symbol, part, and packaging
information.

= Multiple symbols may be assigned to same part.

= Users may design their own symbols, and create their own symbol,
part, and package libraries.

= EDIF processor generates EDIF, net, pin, part, PCPRO, Futurenet,
and Redac reports and tests the schematics for errors. No need to put
power and ground pins on the schematics, they can automatically be
generated from the part library data.
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3.3 PC Board Layout

= Boards up to 32 inches square, 255 masks.

= User selectable cursor layout grid. Items are not limited to fixed grid.
Up to one mil resolution.

= Lines 0.001 to 0.255 inches wide.

= Up to 25 different pad shapes and sizes per board Users may define
their own pad shapes. Different layers of same pad may have different
shapes.

= Up to four text fonts, font editor included. :

= Detailed reports for net list, parts list, connectivity check, board
summary of pads used, widths used, etc.

= Support for power and ground planes, with or without thermal relief.

= Hard copy output allows queuing of up to ten plots.

= Built-in plot panelization for plotting multiple layers per plot.

= Built-in net list name editor.

= Built-in "rat’s net" prompting to aid in optimal component placement
and manual routing of nets.

3.4 PC Board Auto-router

= Inputs and outputs a board file directly compatible withe the PC
board editor.

= Routes multi-layer boards, two layers at a time.

= Routes boards with different lines width, such as wide lines for power
and ground, and normal lines for the other nets.

= Router respects nets pre-routed by the user.

= Router may be interrupted, board edited with PC board editor, and
restarted to finish the routing.

= User selectable routing parameters for line width and clearances.

= User selectable routing strategies.

= Visual display of the routing progress.

= Routing schedule may be generated automatically, by hand, or any
combination of the two.

= Routing schedule may specify routing to a specific layer. This is
required to route to edge connectors and SMD devices correctly.

= Uses a proprietary, state-of-the-art, artificial intelligence algorithm to
route the nets. Routing completion rates are matched only by
mainframe routers costing much more and requiring very expensive

32
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equipment.

3.5 PC Bridge

= Can create/update an EZ-ROUTE PC board from the following
net/pin list formats: EZ-ROUTE, Schema, Orcad, Futurenet, Pcad.

s Can create a net/pin list from an EZ-ROUTE PC board in the
following formats: EZ-ROUTE, Schema, Orcad, Futurenet, Pcad,
Applicon Bravo, Applicon Leap, Computervison, Calay, Cadnetix,
Scicards, Spice, Telesis, Vectron, and Multiwire.

3.6 PC Check: Design Rule Checker

= Checks for net connectivity. Are all points which should be connected
actually connected to each other?

s Checks for nets improperly connected (shorts).

= Checks for pad-to-pad, pad-to-via, pad-to-line, via-to-line, and
line-to-line clearances.

= User selectable clearance values.

= Component, solder side, and inner layers may have different clearance
rules.

3.7 User Support

= Free telephone support during normal business hours. You pay only
for the call.

= If you sign up for our yearly update service, you will receive all
scheduled program revisions as they become available.

= If you do not have the yearly update service, you can get the latest
revision of any EZ-ROUTE program for a small update fee.
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4 Hardware Requirements
The following hardware is required to use the EZ-ROUTE system.

Computer: An IBM or compatible computer with a minimum of
512KB. A hard disk is highly recommended, but floppies
may be used.

Graphics: An EGA, CGA, or Hercules graphics card is required.

Mouse: Microsoft, Logitech, Torrington, Mouse Systems mouse,
or compatible mouse is recommended, but not required.

Printer: A printer/plotter is not required by the evaluation package.
For the real system, a printer is recommended for hard
copy check plots and reports. Access to a pen or
photo-plotter is recommended for final output of PC
board masks.

S Installation of Software

The EZ-ROUTE software may be used directly from the diskettes, or
installed on a hard disk. You will get a much better feel for how the
software works as an integrated design system by installing it on a hard
drive. The following procedure may be used to install the software on
the C hard drive from the A floppy drive. Substitute appropriate drive
letters into the procedure if your system is different.

First, place the disk labeled AMSCAD\PCROUTE into the A drive.

>A: (switch to A drive)
>cD \ (get to root directory)
> INSTALL C (install on C drive)

This will begin the installation of the software on the hard drive. When
prompted, remove the current floppy disk and replace it with the one
indicated until the installation is complete.
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The EZ-ROUTE software is designed to automatically detect the type
of video graphic card in your system. On some clone systems, it may
not be able to detect the video adaptor type correctly. If you have any
problems running the software, or if you wish to explicitly set the video
type, perform one of the following steps which corresponds to your
system:

> AMSCAD /AUTO (Try automatic)

> AMSCAD /EGA (EGA adaptor)

> AMSCAD /CGA (CGA adaptor)

> AMSCAD /HGO (Hercules adaptor,
HGI1-HG3 also available)

This will get you up and running. When you exit the program, with the
File/Quit command, you will be asked if you want to save the current
configuration. Answer Yes. You may now run any of the programs by
just entering the program name. The video type does not need to be
specified.

The EZ-ROUTE programs will automatically detect if you have a
mouse installed. In order to use the mouse, the mouse driver must be
loaded prior to running the EZ-ROUTE programs, usually from the
AUTOEXEC.BAT file. To install a mouse driver, refer to the
installation instructions that came with your mouse.

6 Self-Running Demos

The evaluation package has self-running demos for the schematic editor,
PC board editor, and the auto-router. When a demo is running, it is
"playing back” the user input of an actual session. Therefore, the demos
reflect exactly how the programs really work, and are not a contrived
slide show as done by some other companies.
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6.1 Running from an Installed System

If you have installed the software on your hard drive, enter:

>C: (switch to C drive
> CD \AMSCAD if not already there)
> AMSCAD (run program)

to run the AMSCAD supervisor program. The program will display an
action-bar with pull-down menus. Use the right and. left arrow keys, or
the mouse, to pull-down other menus. To run any of the demos listed
on the menus, move the highlight bar with the up and down arrow keys
to the desired demo. Press the ENTER key (or the left mouse button) to
begin the demo. Be sure to run a demo from each of the menus
(schematic, PC layout, and auto-router).

6.2 Running from Floppy Disks

If you wish to run the self-running demonstrations directly from the
floppy disks, place the desired evaluation disk in the floppy drive and
follow the printed instructions on the reference card included with that
particular disk.

6.3 Controlling a Demo

While a demo is running, you may pause the demo by holding down the
ALT key. The demo will continue when you let up on the ALT key.

You may stop a demo before it reaches the end by holding down both
shift keys at the same time.

6-2



EZ-ROUTE Evaluation Package

7 Tutorials

7.1 Introduction

This section presents two tutorials to give you actual hands-on
experience. The first tutorial leads you through the creation of a simple
schematic. The second tutorial is used to lay out a PC board of the
circuit designed in the first tutorial.

7.2 Manual Notation
The following notation is used throughout the tutorials.

The notation “"XXX" indicates to type the characters shown between
the quotes. For example, "XYZ" indicates to type the characters X, Y,
and Z. Do not type the quotes.

The notation, XXX, indicates to press this single key. For example,
ENTER means press the enter key while G indicates to press the G key.
Unless otherwise noted, either upper or lower case may be used.

The notation, XXX, indicates an item on a menu, or is used to
emphasize particular words.

The notation, (xxx,yyy), indicates a coordinate. For example, (10,15)
indicates the horizontal position is 10 and the vertical position is 15.

The tutorial steps are listed in terms of the keyboard. If you are
configured with a mouse, feel free to use it. The left button of the
mouse is equivalent to the ENTER key, while the right button is the
ESC key. The middle button, if present, may be used as the MARK key
(F10). Any combination of the keyboard and mouse may be used.

Initially, great detail is given. As we proceed through the tutorial you
will learn the basics, less detail will be given.

The print/plot utilities are included in the evaluation kit. If you will be
using a plotter connected to a serial port, refer to appendix A for
additional important information.
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7.3 Schematic Tutorial

This tutorial leads you, step by step, through the creation of a simple
schematic. If you have not yet installed the evaluation software, and
you wish to do so, refer to the previous section for instructions.

7.4 Start Schematic Editor
The schematic editor may be selected from the AMSCAD menu, or run

directly from the demo disk. To run directly from the demo disk, put
the disk in drive A and enter:

>A: (make A drive the default)
>CD \ (switch to root directory)
> CELL (run the schematic editor)

If you have installed the software on a hard disk:

>C: (make C drive the default)
> CD \AMSCAD (where cell is installed)
> AMSCAD (run the EZ-ROUTE supervisor)

Select Schematic editor from the CELL-II menu.

7.5 Loading a Schematic

To get a feel for the system, we will first load a sample schematic file.
We will then learn how to move about the schematic on the display.

Use the up and down arrow keys on the numeric key pad to move the
menu pointer up and down. The NumLck key must be off.

Move the select indicator to the Load entry, and ENTER. This is
referred to as selecting a menu entry.

We are now prompted for the name of a schematic file. At this point,
we could enter the file name of a schematic if we knew it, but since we
do not, press ENTER. Now, we are prompted for the name of a
directory to be searched for schematic files. Press ENTER to use the
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local directory.

A menu of the schematic files on the current directory is now displayed.
Select the VOICE1L.DWG entry from the menu. This demonstration
schematic will be loaded and displayed on the screen, along with the file
menu.

7.6 Getting Help

Press the F1I key to pop-up a window of help information. Notice that
the help information is specific to the current menu item. Press ESC to
remove the help window. Now, move the menu bar up and down to
different items, selecting help on each one with the FI key. If more
help information is available than can fit in the window, a slide-bar will
appear on the right side of the window. Use the PgUp and PgDn keys to
page through the help information.

Help is always available with the F1I key.

7.7 Moving Around a Schematic
We will now learn how to move about a schematic on the display screen.

Press the right arrow key to pull-down the menu to the right. Repeat
until you are on the View menu.

Move the select bar to out and select it. The display will be redrawn at a
smaller scale. You will notice that the out menu item has “PgDn listed
in the right margin. This indicates that this key may be used from the
edit window to perform this same command. Let’s try it. Now, hold the
Citrl key down and press the PgDn key to zoom in. Most menu items
which have a key noted in the right margin may be executed directly
from the edit window. Once you are more familiar with the program,
using these "hot-keys" directly will improve your productivity, especially
if you do not have a mouse.

Zoom back to the original scale by pressing the Ctrl-PgUp key twice.
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The current coordinate of the cursor is displayed in the upper-right
corner of the screen. Use the cursor keys to move the cursor to
coordinate (10,10). Follow the track of the cursor on the screen, and
watch the value in the upper-right corner change.

Holding the Shift key down and using the cursor keys will move the
cursor 8 units at a time. Hold the Shift key down and use the left and up
arrows to move quickly to coordinate (0,0), the upper-left corner of the
board.

The display may be panned from the keyboard by bumping into one of
the edit window edges. Let’s pan right. Move the cursor with the shift
right arrow key until it hits the right edge of the window. The portion of
the schematic that was out of view to the right of the screen is now
displayed.

With a mouse, you may also pan by placing the cursor in one of the
windows that surround the edit window, such as one of the rulers. The
cursor will change to an arrow. Press ENTER to pan in that direction.

Display the upper-left corner of the sheet by pressing Ctri-Home.

7.8 Cursor Grid

The little dots that you see on the screen comprise the cursor grid. It is
used to give the user reference points to assist in the schematic layout.
It is not part of the schematic, and is not printed on hard copy output.
'The grid may be turned on or off. Type ¥ to pull-down the view menu
and type G to select grid. Notice that the grid has been removed from
the display.

This completes a summary of how to start the CELL-II editor, load an
existing schematic, view the schematic, and control the cursor grid.
Type ALT-G to turn the grid back on.

7.9 Creating a New Schematic
Our assignment is to create a small board entirely from scratch. We

must layout the schematic drawing for the circuit. This circuit is
intentionally small; however, it demonstrates the basic steps by which
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any circuit, regardless of size, is created. A rough, hand-drawn sketch
of the circuit is given in Figure 7-1. This is the way actual schematics

normally start out.

An experienced designer may use CELL-II to

directly enter designs without the use of rough sketches.

Specific requirements supplied by the designer are as follows:

1.
2.
3.

Use TTL logic.

PC Board size is 4.00" x 4.00".
Board has 2 signal layers,
route with 12 mil lines.

. Power and ground provided by

power planes.

1920

DA.‘{-Qc.'de’ C U’CW-{-

~4

Figure 7-1. Rough .Skctch of Circuit

We have all the information we need. We are now ready to begin our
schematic. Go to the File menu (F) and select New. If you have made
any changes to the schematic we have been viewing, you will be

prompted whether or not you really want to abandon the changes. If
prompted, type Y for yes.
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We are presented with a menu of drawing sizes to choose from. Since
we have a simple circuit, select the A size drawing. Now, we have a
blank A size sheet to work on.

7.10 Placing the Parts

We are now ready to place the parts of our circuit on the sheet.
Pull-down the Library menu and select Load Part. We will first place the
four-input NAND gates on the sheet. Enter 7420 for the part name
and press the ENTER key. The program will search the parts libraries
for the indicated part. The cursor is now a rectangular area, indicating
the size of the symbol for this part. Move the cursor to coordinate
(8,5). ENTER to place the symbol at the point. Since this particular
part has more that one gate, we are now prompted for which section
(gate) of the part we want to use. Select the 4 section. Now we are
prompted for the instance number to assign to the symbol. Just
ENTER to accept the U1 value. Now the symbol, with the pin numbers
per the section and instance number we assigned are displayed.

Now, let’s add the other gate. Move the cursor to (8,17) and ENTER.
Accept the suggested section, B, and the instance number, U1 with the
ENTER key. Notice that the two NAND gates that we added to the
schematic are really contained in the same physical part.

Now we will add the flip-flops. First, enter ESC to cancel adding any
more of the 7420’s. Now, select Load Part from the library menu. Enter
7474 for the part number. Move to (27,5) and ENTER to place the first
flip-flop. Accept the suggested part section and instance number. Now,
move to (27,17) and place the other half of the flip-flop. Isn’t this much
easier than drawing the parts every time?

Now we will add the 330 ohm resistors to the schematic. ESC from the
previous part. Load the resistor part R.330. The period is part of the
part name. Place this resistor value at coordinate (40,10) and (40,22) as
R3 and R4.

Now we will add the light-emitting diodes to the schematic. In this case,
we will intentionally make a mistake, and recover from it. Load the part
LED-1. Place the first LED at (52,8). Now look at the orientation of
the LED on the screen. You will notice that the cathode end of the
LED is on the wrong (right) side. This is not what we want. Press the
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FI0 key. Now, we have a list of possible symbols for this part. Select
the LED.HL (HL for horizontal left). Now place the part again in the
same coordinate (52,8). Since something is already here, we will be
prompted if it is ok to place this symbol on top of what is already here.
Answer yes for the override protection and overlay prompts. When
prompted for the instance number, set it to D5 (the original D5 was
wrong). Now, we have an LED pointed in the right direction. Now
place the second LED, D6, at coordinate (52,20).

We now have all of our true parts placed. The pseudo-part, the
connector, will be constructed "on the fly" later.

1
2 PR ,s
—ui 6 b al=
21420 3 abt | 2 Vo 2
3 i P r.330
—dor led~1
J474
vz
.. 10—
ol n - Lo
121420 T ob® 1 R4 2 T =
—AAA—
13 b r.330 4
CLR led =1

Figure 7-2. Parts Placed on Schematic

7.11 Wiring the Circuit

Since all of our parts are placed, we are now ready to wire them
together. First, let’s wire the connection from U1 pin 6 to U2 pin 11.
From the Edit menu, select the Wire Net command. Move the cursor
to (20,9). ENTER to begin the net line. Move to (21,9) and ENTER to
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draw a segment of the net. Move to (21,11) and ENTER. Move to
(27,11), ENTER to draw the segment, and ESC to stop drawing this
net’s lines.

Now, let’s make a similar connection from U1 pin 8 to U2 pin 11. Move
to (20,21) and ENTER to start the net line. Move to (21,21), ENTER,
(21,23), ENTER, (27,23), ENTER, and ESC.

Got the hang of it? In actual practice, the wiring process is even easier
because you are drawing the lines by looking at the points that need
connecting on the screen instead of working from a list of points as we
are doing here. If you add a line in the wrong place, simply remove it by
drawing another line over the wrong portion.

Now, connect the following points with a net line. Remember to use
ESC to stop drawing one net before starting the next net line.

U2:6, R3:1  (38,11) to (40,11).
D5:1, R3:2  (49,11) to (52,11).
U2:8, R4:1  (38,23) to (40,23).
D6:1, R4:2  (49,23) to (52,23).
D5:2, D6:2 (60,11) to (63,11) to
(63,23) to (61,23).

Now, move the cursor to (63,23). At this point, we want to add a
connect dot and continue the net. ENTER to start the line. Now,
without moving the cursor, ENTER again. This will add a connect dot.
From this point, move to (63,30) and ENTER. Continue this net line to
(23,30), (23,21), and into U2 pin 12 at (27,21). Now ESC and move
back to (23,21). Add a connect dot here, and continue the net to (23,9)
and end at U2 pin 2 (27,9). Move to (23,30) and add a connect dot.
Continue the net to (0,30). This is actually two grids to the left of
where we want to be; but, we are intentionally making this mistake so
we can correct it later with the Drag command.

7.12 Making a Connector

At this point, let’s assume that we do not have a part or symbol in the
library for the connector. We will build the connector directly on our
schematic. The procedure demonstrated here shows how to make a new
symbol for a part. If we wanted to, we could store it into one of the
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libraries for use on other circuits. All symbols are made in this fashion -
draw it once on a schematic and store it into a library.

At the current point (0,30), we will terminate the net with a connector
(or off page reference) indicator and build a part for it. This is just like
adding a connect dot, except ENTER one more time to convert the
solid dot to an open dot. If we wanted to, we could ENTER one more
time to remove the dot.

From the Edit menu, select the Copy command. Move to (0,30) and
MARK (F10 or the middle mouse button) to begin marking an area.
Now move to (7,30) and MARK again to complete marking the area.
At this point, the area we want to copy is marked but has not yet been
selected for copying. ENTER while the cursor in within the marked
area to select it (where the cursor is now is just fine). The cursor now
has the shape of the area we are about to copy. Move to (0,32) and
ENTER. We have placed a copy of the connector lead we just drew at
this point. Now, move to (0,28) and ENTER to place another
connector lead here. Continue this procedure to copy the lead to the
following coordinates:

(0,24) U1:13
(0,22) u1:12
(0,20) U1:10
(0,18) u1:9
(0,12) uv1:5

(0,10) U1:4
(0,8) U1:2
0,6) U1zl

ESC to stop copying. As we said before, the connector has been
located two grids left of where we really want it. From the Edit menu,
select the Drag command. Move to (0,5) and MARK to start marking
an area. Move to (2,33) and MARK to complete the marked area.
Select the area with ENTER. To get a better feel for how this command
works, use the keyboard arrow keys for the next few steps, even if you
have a mouse. Press the right arrow key. Notice how the entire marked
area moved to the right. Press the right arrow key three more times.
Now press the left arrow key two times to move it to the left. Notice
that the net lines have been stretched and not broken. This is a very
handy command. The area should now be two grids to the right of
where it was before we dragged it. This is where we want it.
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Now let’s add the pin numbers for the connector. From the Edit menu
select the Text command. Now type ALT-P, or use the mouse, to
pull-down the Property menu. Notice that to pull-down a menu from
the keyboard while in the text command, it is necessary to hold the
ALT key down and type the menu select character. If you just typed
the menu character, that clraracter would be typed onto the schematic.
F9 may also be used to pull-vdovm the property menu.

Select the Input property fl"om this menu. Now move to (3,5) and type
the character 1 for pin number one. Move to (3,7) and type 2 for pin
number two. Proceed to label the connector points as follows:
|

3 at (3,9

4 at (3,11) |

5 at (3,17)

6 at (3,19) ‘

7 at (3,21)

8 at (3,23) '

9 at (3,27) ‘

At this point, select the er property from the property menu.

10 at (3,29) ‘
11 at (3,31) ‘

: |
Now, we have all the connector pins identified with their pin numbers.
It is important to note ?t this point that the property selection is
important. We not only put the text characters on the schematic, but
we also encoded the information that the characters represent input
pins and power pins. |
Now, we will add the connector instance (name) and part number.
Since we are tight for space, we’ll add the text vertically. Select the
Instance property. From ihe Option menu (ALT-0) select the Vertical
text option. Move to (1,12) and type "CONN". Now select the Part
property. Move to (1,25) and type "EC.12". From the option menu, set
the text mode back to Horizontal text.

Now, we will convert the1 connector we have just draw into a symbol.
From the Edit menu, select the Symbolize command. Move to (1,4)
and MARK. Move to (3,33) and MARK. ENTER to convert the area
into a part symbol. Note|that the unused area of the symbol has been
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converted to blanks, and the symbol corner designators have been
added.

To make the connector stand out a little, we will add a little decoration
around it. From the Edit menu select the Lines command, and from
the Property menu, select the Unassigned property. Unassigned means
this item has no circuit meaning, it is here just for artistic or notation
purposes. From the Option menu, select the Dashed line type (shown
graphically on the menu). Now, draw a line, just as we drew nets,
between the following points.

(5,5) to (5,3) to (0,3) to (0,34) to
(5,34) to (5,33) stop.
(5,27) to (5,25) stop.
(5,17) to (5,13) stop.

Now, we will add the net names for the nets which have names. Select
the Net Name command from the Edit menu. This works just like the
text command we have already used, except the property is
automatically set to Net for you. Add the following net names at the
given locations:

11 at (6,5).

12 at (6,7).

13 at (6,9).

14 at (6,11).

15 at (6,17).

16 at (6,19).

17 at (6,21).

18 at (6,23).
RESET at (6,27).
+5V at (6,29).

Pin 11 of the connector is the ground net. We will show this by using
the ground symbol. First, use the Edit/Wire Net command to extend
the net line from connector pin 11 to (15,32) and down to (15,34).
Now, select the Libr et bol command. Enter "GND" for the
symbol name. Note that the ground symbol is a symbol and not a part.
Place the symbol at (15,34). Answer yes to the overlay question. Now,
this net is connected to ground. We could have accomplished the same
effect by labeling the net as GND.
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We need to complete the wiring for the RESET net. In drawing this
net, we will demonstrate another way of drawing lines. Select the
Edit/Wire net command and move to (27,13). Now, press F2. This
enables the draw step mode. This method will work only from the
keyboard. With the arrow keys, move left to (25,13), then down to
(25,25), and right to (27,25). | Notice how the line is drawn as the cursor
moves. If you make a mistake, just move back over the line to undraw
it. Press F2 to switch back to move mode. Move to (25,25) and
ENTER twice to add a connect dot. F2 to enter step mode. Move
down to (25,28) and left until the RESET net is' completed. This
method of drawing lines is very effective in tight spaces, and for
correcting mistakes.

Now, we will complete our jschematic by adding some notational text.
Select the Edit/text command and the Unassigned property. Move to
(23,32). MARK to establish a left margin. Enter the following text.
Note, with the left margin p sent, just type the text like on a typewriter.
ENTER functions like the

Notes:
1. Layout on a 4" x 4" board.
2. Power and ground planes required

Now, move to (25,2). Select Bold text from the Option menu. Type
"Detector Circuit”. Now, select the Edit/Lines command and the
Double line type. Draw a line around the text we just added.

7.13 Saving the Schematic

This completes the tutorial schematic. Let’s save it to disk. Select the
File/Save as command. |Enter MYDEMOQ for the name. The
cvaluation version of tTc program will not actually save the
drawing.
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Figure 7-3. Finished Schematic

7.14 Exit the Editor

We are finished with the schematic for now. Select Quit on the File
menu to exit the program.

7.15 Summary of Schematic Entry

Let us emphasize that the entry of the tutorial schematic may seem a
little tedious. This is because we have stepped you through each of the
steps at a very detailed level. In actual practice, you are choosing your
own locations for parts, paths for the nets, and the order in which you
wish to layout the circuit. Just follow the principles you have learned
here and it will flow very smoothly.
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|
8 PC Board Layout 'l‘utt+'ial

This tutorial leads you, step M step, through the creation of a simple
PC board. The board corresponds to the schematic created in the
previous tutorial. If you have not performed the schematic tutorial,
please refer to sections 7.2 and 7.6. These sections explain the manual
notation used in the tutorial
|

Although we will be using the results from the schematic tutorial to lay
out the tutorial board, it should be emphasized the PCPRO-II system
may be used to lay out a board entirely from scratch, or from the net
lists from several other | systems.

8.1 Start PC Board Editor

The PC board editor may be selected from the AMSCAD menu, or run
directly from the demo disk. To run directly from the demo disk, put
the disk in drive A and enter:

>A: (make A the default)
>0\ (change to root directory)
> PCPRO (run PC ediripmgmm)

If you have installed the software on a hard disk:

>c: (make C drive the default)
> CD \AMSCAD (where installed)
> AMSCAD (run the AMSCAD supervisor)

Select PC BOARD ED from the PCPRO-II menu.

|
|

|
To get a feel for the system, we will first load a sample board file on the

release disk. We will then|learn how to move about the board on the
display.

8.2 Loading a Board
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Move the select indicator to the Load entry, and ENTER.

We are now prompted for the name of a board file. At this point we
could enter the file name of a board if we knew it, but since we do not,
press ENTER. Now, we are prompted for the name of a directory to be
searched for board files. Press ENTER to use the local directory.

A menu of the board files on the current directory is now displayed.
Select the SAMPLE1.PCB entry from the menu. This demonstration
board will be loaded and displayed on the screen, along with the file
menu.

8.3 Moving Around a Board
We will now learn how to move about a board on the display screen.

Press the right arrow key to pull-down the menu to the right. Repeat
until you are on the View menu.

Move the select bar to jn_and select it. The display will be redrawn at a
larger scale. Zoom in again. You will notice that the in menu item has
“PgUp listed in the right margin. This indicates that this key may be
used from the edit window to perform this same command. Let’s try it.
Press the ESC key to roll-up the pull-down menu and switch to the edit
window. Now, hold the Ctrl key down and press the PgDn key to zoom
out. All menu items which have a key noted in the right margin may be
executed directly from the edit window. Once you are more familiar
with the program, using these "hot-keys" directly will improve your
productivity, especially if you do not have a mouse.

It should be noted that if you pick the pan and zoom commands
directly, you do not need to wait for the redraw to complete before
entering another pan or zoom command. In this case, the current
redraw will be stopped, and the next redraw will begin directly.

The current coordinate of the cursor is displayed in the upper-right
corner of the screen. Use the cursor keys to move the cursor to
coordinate (1900,900). Zoom in or out if necessary. Follow the track of
the cursor on the screen, and watch the value in the upper-right corner
change.
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Function key F8 is the locat¢-text command. This command is used to
locate a text string on a board. Press F8 and enter "U005" ENTER for
the search (in the input window). The program will pan the display so
that the located string is displayed. The position of the cursor is the
coordinate of the text.

The display may also be panned from the keyboard by bumping into one
of the edit window edges. Let's pan down. Move the cursor with the
down arrow Kkey until it hits the bottom edge of the window. The
portion of the board that was below the bottom of the screen is now

displayed.

With a mouse, you may also pan by placing the cursor in one of the
windows that surround the edit window, such as one of the rulers. The
cursor will change to an arrow. Press ENTER to pan in that direction.

Display the whole board by pressing Ctri-Home.

Holding the Shift key down and using the cursor keys will move the
cursor eight units at a time. Hold the Shift key down and use the left
and up arrows to move ‘j’uickly to coordinate (0,0), the upper-left
corner of the board.

8.4 Selecting Layers for Display

We will now explore how fto select the layers of information that are
displayed on the screen. This is controlled by selecting Display layers
from the view menu. To pyll-down the view menu, press the V key. We
could also have pressed ESC and then moved right or left to get to the
view menu.

Select Display layers to pop-up the display layer control menu. You will
notice that each layer of {the board is listed along with its type and
current display color. If the color is off (same color as the PC board
background), then that layer will not be displayed. The actual colors
and number of colors available will depend on your particular
hardware. The display state of each layer is changed by pressing ENTER
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pressing the ESC key. The display will be redrawn per the new settings.
Notice that only the component layer is displayed.

Now, let’s display just the solder-side layer by entering D, set the
component !ayer to off, set the solder-side layer to the color of your
choice, and ESC. Only the solder-side is displayed.

8.5 Cursor Grid

The cursor grid is set to 50 by default. You have probably noticed that
the cursor steps 50 units each time the arrow keys are pressed. Select
the Grid entry from the View menu. Move the pointer to the X grid
selection and ENTER. Enter "25" and ENTER. This sets the X cursor
grid value to 25. Do the same for the Y grid. Now, press ESC to exit
the grid menu. Move the cursor about the screen with the arrow keys.
Notice that the cursor now moves in steps of 25.

This completes a summary of how to start the PCPRO-II editor, load an
existing board, view the board, control the display of selected layers,
and set the cursor grid.

8.6 Layout of a New Board

Our assignment is to lay out a small board which corresponds to the
circuit we drew during the schematic tutorial. After drawing a
schematic, the normal procedure is use the EDIF processor to print a
parts list, a net list, and to create an initial PC board from the schematic
data. Since the EDIF schematic processor is not included in the
evaluation kit, the PC board file, MYPCB.PCB, is included. This file
was produced by the EDIF processor, and is the initial PC board
corresponding to the tutorial schematic circuit. The EDIF processor
generates a board file which contains all the components and pin/net
name assignments specified on the schematic.

This board is intentionally small; however, it demonstrates the steps by
which any board, regardless of size, is created. The schematic, parts list,
and net list produced by the EDIF processor are given in Figures 8-1
through 8-3.
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Additional specifications are as follows:

1. Board size is 4.00" x 4.00v,

2. Board has 2 signal layers,
12 mil lines.

3. Power and ground provided by
power planes.

4. Solder mask required.

5. Silk screen required.

6. Drill drawing required.
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Figure 8-1. Schematic Drawing
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Part List
---#--Part---Count--Instances-----
¥ e 1 CONN
2 320 2 RO003 ROO4
3 LED 2 D005 D006
4 Ls20 1 U001
5 LS74 1 uoo2
Net List
---#-Net name---Nodeg----==--=-=----~
1 #001 uo02:3 U001:6
2 #002 u002:6 RO003:1
3 #003 RO03:2 DO0O05:1
4 #004 u002:11 U0D1:8
5 #005 U002:8 RO04:1
& #006 R004:2 DOO06:1
7 +5V CONN:9 U002:2
D005:2 U002:12
D006:2 U001:14
U002:14
8 GND CONN:11 U001:7
uoo2:7
N CONN:1 U001:1
10 12 CONN:2 U001:2
113 CONN:3 UO001:4
12 14 CONN:4 U001:5
1315 CONN:5 U001:9
14 16 CONN:6 U001:10
15 17 CONN:7 U001:12
16 18 CONN:8 U001:13
17 NC u002:5 Uu002:9
18 RESET CONN:10 U002:1
u002:13

Figure 8-2. Part and Net List

We will begin the layout by loading the initial board file created with the
EDIF processor. Select the Load entry on the File menu. Since we
already have a board loaded, we will be questioned as to whether or not
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we wish to lose the changes made to the current board. Answer Yes
when prompted.

Enter "MYPCB" and ENTER to load the initial PC board for our
tutorial.

8.7 Optimizing Board Placement

The placement of the parts on the board, as it comes from the EDIF
processor, is not optimized. Our first step in completing the layout is to
shift the components around on the board to make the layout of the net
lines easier and more electrically efficient. Also, any components which
must be restricted to a given location are placed at this time.

mypchb . pch a:All 0, )
File Edit Hssign View Options Reports Systen
G o i

n
-

Fi.Help, ESC:Henu

Figure 8-3. Initial EDIF Board

Select the Components command from the Edit menu. Move to
location (700,900) and ENTER to select component "EC-12". Move to
location (150,1000) and ENTER to place the connector. ESC to release
the component. This is how components are moved about on the board.
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Now, move to (550,2450) and select component "U001". Move to
(650,600) and ENTER to place it. Now press the N key to display a rat’s
nest of connections from the selected component. This is used to aid in
placing components. By being able to see how a component connects to
other components, it is easier to optimize the component placement.
Press the N key again to turn off the rat’s nest display. ESC to release
the component.

Use the method just learned to place the remaining components as
described below. If you like, use the N command to show the rat’s nest
as the components are placed. In actual practice, you can select a
component by placing the cursor anywhere within its area. For
agreement with the rest of the tutorial, use the following exact
coordinates as you make the placement. The coordinates given are pin
one of that component.

In the following exercises, you may want to use the "locate cursor”
command. This command may be used to directly position the cursor
to an exact coordinate. To use this command, just press F4 and enter
the x and y coordinates.

U2 at (550,3450) to (650,2100).
RO0O3 at (550,4750) to (1500,1150).
D005 at (550,4400) to (2500,1150).
ROO4 at (550,5450) to (1500,1600).
D006 at (550,5100) to (2500,1600).
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COMPONENT: Hot selected : B:A11 8508, 750
File Edit Hssign Uied Options Reports System
[ [ 3

elp, ENIER Select component., L Laver, ESC:Henu

Figure 8-4. Board after Placement

8.8 Set Board Size

Now that the board is placed, we will set the board to the specified size.

Select the Edit/Board Size command. Select Xhigh and ENTER. Set
the value to 4000 (1 inch is 1000 mils). Likewise, set Yhigh to 4000.

8.9 Add Power/Ground Layers

While we are in the board size function, we will also add the power and
ground layers. Select the # layers and change the value from 4 to 6.

Now, select the Layer types function. Select layer S which has type
"none" and change its type to Power/ground. Do the same for layer 6.
Press the ESC key twice to complete the board size function.
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At this point, we have added two layers to the board and designated
them as power/ground types. Now, we will assign a net name to each of
these two layers. Select the Gnd/pwr layer command on the Assign
menu. Select layer § and enter "+5V" for the name. Likewise, assign the
net name "GND" to layer 6.

8.10 Routing the Board

We are now ready to add the routes that connect the pads together to
make the desired circuit. Once again we will work directly from the net
list given in Figure 8-2. Select the Lines command from the Edit menu.

First, we will choose the desired width of the route lines. From our
specification, this is 12 mils. Enter O and W (for option/width), and set
the value to 12. For this board, we will use the component-side for the
mostly horizontal routes, and the solder-side for the mostly vertical
routes.

From our list, we will route the #001 net first. This net connects from
U002 pin 3 to U001 pin 6. Move the cursor to U002 pin 3 (650,2300).
Set the layer to the solder-side. Press the N key. This will display a
prompt-line to the nearest pad that this pad connects to. This is for
reference only, the line is not part of the board; however, it is extreriely
helpful in routing boards by indicating what pads nced to be connected
together. The line may be turned off by pressing the N key again. Press
the N key several times to flash the path. Leave the line turned on for
the next step.

We are now positioned on one end of the route to be made, and we
have an indicator showing where we are going. ENTER to begin the
route. Now, move to (750,2300). Notice that the line we are about to
draw is displayed. ENTER to add this segment to the board. Now,
move to (750,1100) and ENTER. Move to (650,1100) and ENTER.
This completes this route and this net. ESC to terminate this line.
Press N to remove the net-prompt line.

Now, we will route the next net, #002 which connects U002 pin 6 to
R003 pin 1. Move the cursor to the location of U002 pin 6 (650,2600)
and press N. Route this net as follows: Use the T key to toggle to the
component-side. ENTER to start the net. Move to (800,2600) and
ENTER. At this point we will add a via and switch to the other side of
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the board by pressing ENTER again. Move to (800,1150) and ENTER.
ENTER again to add a via here. Move to (1500,1150) and ENTER to
complete this route. Enter ESC to terminate the route and N to
remove the net-prompt. Net #002 is now complete. Now, let’s guide
you through one more net, #003. Move to U002 pin 6 at (2000,1150).
N to display the path prompt. This is an easy one! ENTER to start the
line, move to (2500,1150), ENTER to add the line, and ESC to
complete this net.

This is how nets are routed. See how the net names assigned to pins
really pay off!

Now, use the net list and proceed to complete the rest of the nets on this
board, just like we routed the first three nets. Warning! When you
make a route to one of the connector pads, remember that these pads
are only on the component-side of the board. Make sure your
connection to the pad is also on the component-side. Also, the
connector pads for nets +5V and GND may be connected to the power
layers by routing a short line and ending it with a via. The via will
connect to the power plane of that net name.

T
|

Solder Side

,
et

-
L
—

Figure 8-5. Component & Solder Sides
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8.11 Adding Text

Additional text, other than the component instance numbers, is often
added to identify the layer of the mask, the company name, copyright
notice, etc.

Select the Text command form the Edit menu. Set the working layer to
the component side layer. Enter OS (option-size) and set the text size
to 62 mils (1/16"). Move to (1000,300) and ENTER to add a text string.
Enter "Copyright (c) 1988 by Me". The text will appear on the board at
the location of the cursor and have attributes which match the current
settings displayed at the bottom of the screen.

Enter OA (option-angle) and select Up for the angle. Move to location
(3500,2000). ENTER and add the string "Component Side”. Set the
layer to Solder-side. ENTER and add the string "Solder Side".
Likewise, add the names for the Power, and Ground layers.

You may add any additional text as desired. If you add text on a
conducting layer, be careful in placing it so as to not make a short. Set
the angle, size, and mirror factors as desired from the option menu. To
change the factors for an existing text string, set the parameters to the
new desired values, place the cursor on the string and enter U. Change
the string if required and ENTER to complete the update of the text.

To delete a text string, place the cursor on the text, set the layer to the
layer for the text and DEL.

8.12 Crop Marks

To complete the board, add alignment marks in each of the board
corners. Use a line width of 1 mil and apply the lines to the all layer.

8.13 Reports

Pull-down Reports from the main menu. Generate a parts list a net list
(pads only option), and a Summary report. If you have a printer, enter
"PRN" for the device name. This will send the reports directly to the
printer. Compare these reports with the input net and parts lists. They
should agree.
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In actual practice you would not have to make this comparison
manually. The PC-BRIDGE utility (not included in the evaluation kit)
would be used to verify that the PC board layout agrees with the
schematic design data. The utility is also be used to update the design
information (component and pin/net names) for a board when changes
to a schematic are made.

8.14 Saving the Board

Select save As from the File menu. Enter "MYBOARD" and ENTER.
The cvaluation version of the program will not actually save the
board to a disk file.

8.15 Exit the Editor

We are finished with the board for now. Select Quit on the File menu
to exit the program.
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9 PC Board Auto-router

In actual practice, the EZ-ROUTE auto-router is used to automatically
route the connections for a board. Although the router cannot route
every board to 100% completion, it does perform the vast majority of
the board layout.

Before a board is routed, the board is first "scheduled". The schedule
program gets a board ready for routing by determining which points on
the board need to be connected. The schedule may be adjusted, or
entered directly, with the PCPRO-II editor.

Once the board is prepared, the auto-router uses artificial intelligence
to route the connections of the board. The auto-router will preserve
any nets that you have pre-routed. Also, the auto-router may be
interrupted while it is running. At this point the PCPRO-II editor may
be used to manually make adjustments to the board. The board may
then be resubmitted to the auto-router to continue the remainder of
the routing. i

For a demonstration of the auto-router, run the AMSCAD supervisor
program and select the Auto-router/Demo command.
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Figure 9-1, Auto-router in Action
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10 Summary / Ordering Information

Thank you for taking the time to evaluate this software package. We
hope it has been an enjoyable and educational experience. If you find
that you still have questions, give us a call at (305)-975-9515.

To order.the EZ-ROUTE system, or any of its subsystems, just call toll
free 1-800-9PCFREE to enter your order. Don’t delay; order today!

EZ-ROUTE

CELL-II

PCPRO-II

PCROUTE

PCCHECK

Integrated CAE system includes AMSCAD
supervisor, CELL-II schematic system, EDIF
schematic processor, PCPRO-II board layout system,
PCROUTE auto-router, PLOT and PCPLOT hard
copy utilities, EDFONT font editor, PCBRIDGE
convert/update program, part and symbol libraries.
Does not include PCCHECK.

Includes CELL schematic editor, EDIF schematic
processor, PLOT hard copy utility, and EDFONT
editor, part and symbol libraries.

Includes PCPRO layout editor, PCPLOT hard copy
utility, EDFONT editor, PCBRIDGE convert/update
program, part footprint library.

Includes PC board auto-router and PCSCHED
scheduler.

Includes PC layout design rule checker.
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A - APPENDIX: Additional Print/Plot Information

Hard copy output for schematics is generated with the CELL program.
PCB masks are plotted with the PCPLOT program. These programs
may be run directly or from the AMSCAD supervisor.

These are high performance programs, capable of generating output
faster than an output device can plot the information being sent to it.
For plotters which are connected to your system via a serial port, you
must use a cable which has the proper handshaking wires in it. This
allows the plotter to signal the computer to wait until it catches up.
Standard RS232C cables have the proper wires; however, homemade
three-wire cables do not.

If you do not have a proper cable, the plotting will initially be correct.
Once the buffer of the plotter becomes full, the pen will appear to make
random movements and draw random lines on the plot. If it is a small
plot, you may sneak by.

The default serial port settings for the EZ-ROUTE programs are 9600
baud, no parity, and one stop bit.

Compulter Plotter

1 Protective Ground

2 Transmit Data

| 3 Receive Data

5 Clear to Send

6 Data Set Ready

7 Signal Ground

8 Carrier Detect

20 Data Terminal Ready
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Figure A-1. Cable Circuit with Handshaking




